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1  The CROSS software 
 
The CROSS software calculates the first coefficient of soil reaction (Winkler coefficient) using results of 

explorations. The software implements a procedure developed by NIIOSP experts (a description of the procedure 
previously published as the article “Predicting subsidence in foundations of shallow expansion and selecting a 
subgrade model for slab analysis”). 

The CROSS software finds the subsidence (and thus Winkler’s coefficient of soil reaction) allowing for a 
distributive ability of the foundation. This feature helps use results obtained with the program to find the stress and 
strain in a structure (using SCAD or other software) without specifying the second, Pasternak’s, bedding value. 

1.1 Coordinate system 

A right-oriented Cartesian coordinate system is used (X, Y, Z). The Z axis is a longitudinal axis of a 
structure or a building directed from the plane of the drawing towards the observer. The Y axis is vertical and looks 
upwards on the drawing, and the X axis is horizontal with its positive direction to the right. 

1.2 Files created by the program 

The CROSS software creates, reads, and writes its results in files with the extension .crs. 

1.3 Model and source data 

A construction site is under consideration on which the designed structure will be placed together with 
other objects (buildings either existing or being erected) that affect the main structure in the sense that loads upon 
the soil caused by those objects may lead to a subsidence of the designed foundation. It is assumed that the spots of 
the designed object and its adjacent structure can be represented as closed polygons (possibly, with openings). Each 
of the polygons will transfer a load to the soil, the load being applied at the founding level. Also, it is assumed that 
there are known results of the site explorations represented as information about properties of the soil in a set of 
boreholes. The relief of the site’s day is assumed to be smooth and specified as a set of marks of the boreholes’ 
mouths. No other exploration data are used. The data are entered using a coordinate grid with its spacing specified 
by the user. The following sequence is recommended for creating an adequate model: 
 specify outer dimensions of the construction site; 
 enter parameters of the coordinate grid; 
 enter the outline of the foundation slab; 
 enter the outlines of existing buildings (if necessary); 
 specify openings (if there are any); 
 smooth down angles (if necessary); 
 specify loads; 
 specify founding levels; 
 specify locations of boreholes; 
 enter soil data; 
 specify the boreholes’ parameters. 

The result of the analysis will include a set of values for the coefficient of soil reaction (Winkler’s 
coefficient) in any point of the foundation slab. 

The technique and procedure for this analysis have been developed by V.G. Fedorovsky. Key principles of 
the technique were presented in the paper by V.G. Fedorovsky, S.G. Bezvolev ““Predicting subsidence in 
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foundations of shallow expansion and selecting a subgrade model for slab analysis” // Foundations, basements, soil 
mechanics. 2000. N4. P. 10–18. By courtesy of the authors, this paper is annexed to the present document. 

1.4 Controls 

1.4.1 Main window of the program 

The main window of CROSS (Fig. 1.4.1-1) contains a menu, a toolbar, a working area (with scrollbars 
if necessary), and a status bar. 

 
 

 

Fig. 1.4.1-1. A general view of the CROSS main window 

Menu Toolbar 

Working area 

Status bar 
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1.4.2 Settings 

 

Fig. 1.4.2-1. The Report and Languages 
tab of the Settings dialog box  

The program can be adjusted to the user’s preferences 
using appropriate settings such as units of measurement for 
physical values or report generation rules. These adjustments can 
be made in the Settings multi-tab dialog box. The Settings dialog 
is invoked via the Settings menu item or by clicking a toolbar 

button (its name is Settings and it looks like ). You adjust 
settings in the same way as described in Section 3.2. The difference 
is that the following additional operations are included: 

 the most recent project can be opened automatically when 
the program starts; 

 the number of points on a full circle can be specified for 
the purpose of angle rounding; 

 the mouse pointer can snap to nodes of the grid; 
 nodes can be displayed on a contour. 

 
If the Open last project by default option is checked, the program will load the most recent project when 

starting. 
The Circle property defines the number of points to be used to approximate an inscribed circle by a 

polygon. If an angle is to be rounded, the number of points on the rounded arc will be appropriately proportional to 
the central angle of the arc. 

The Snap to grid option, when checked, helps associate boreholes and salient points of contours with 
nodes of the given grid. This feature is used to build contours of foundations and to assign locations of boreholes. A 
point snaps to the node of the grid nearest to the mouse pointer in its current position. 

If the Show nodes option is checked, nodes (salient points) will be displayed on contours. 
 On the Analysis tab, you can set the ratio zp/zg between an additional vertical stress (zp) and a vertical 
stress caused by the soil’s dead weight (zg). This ratio will determine the boundary of the compressible soil massif. 
The default value for this ratio is 0.2 which complies with SNiP 2.02.01-83* Foundations of buildings and 
structures, though you can specify any number from the interval [0.10.5] in compliance with requirements of a 
new draft SNiP document. 
 This tab also contains the Save results of analysis checkbox. If it is enabled, then results of the analysis 
performed will be saved whenever the model is saved (provide the analysis has been actually performed). Turning 
this feature on will increase the size of the model’s file dramatically. The advantage is that after restarting the 
program and re-loading the model you don’t have to perform the calculations again; instead, you can pass to the 
reviewing of its results. 
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1.4.3 Menu 

 
The main menu is located at the top of the window and includes five drop-down menus: File, Edit, 

Properties, Tools and Help. 
The File menu includes this set of actions: 

 New — create a new site (the hotkey combination is Ctrl+N); 
 Open — load a previously created site (the hotkey combination is Ctrl+O); 
 Save — save the current site to disk  (the hotkey combination is Ctrl+S); 
 Save As… — save the site (the model’s file) under a new name; 
 Import DXF, DWG ... — import data about the bedplate’s geometry from a file of the DXF or DWG 

format; 
 Calculate — calculate the coefficients of the soil reaction; 
 Report — generate a report; 
 Fields — display isofields of the soil reaction coefficients. 
 Subsidence ... — display isofields of distribution of the bedplate’s base subsidence; 
 Load field — visualize isofields of loads if the load upon the bedplate is non-uniform; 
 Save picture — save the picture currently on the screen in a Windows metafile format. 

The Edit menu comprises the following actions: 
 Undo — cancel the latest performed action; 
 Redo — cancel the latest Undo command; 
 Dimensions — specify overall dimensions of the site on which the designed structure will stand together 

with other objects that may influence it (this action and all the following ones in this menu duplicate the 
respective buttons of the toolbar); 

 Foundation — enter and edit the outline of a foundation slab; 
 Existing building — enter and edit the outline of a building that stands beside the designed structure and 

has an effect on the latter; 
 Opening — enter the outline of an opening; 
 Delete — delete an existing building and/or opening; 
 Round angle… — round a selected angle by a circular arc of a specified radius; 
 Move — move vertices of the contours of the foundation or existing buildings; 
 Vertices — edit the coordinates of vertices of the foundation or existing buildings; 
 Delete vertices — delete one or more vertices; 
 Assign foundation — assign the foundation of an existing building to be the bedplate for the analysis; 
 Load — specify a load upon the foundation (or an existing building) and the founding level; 
 Create are of extra load — create an area in the foundation subject to an additional load; 
 Delete area of extra load — delete an area subject to an additional load; 
 Change load on area — edit the value of a load applied to an additional area; 
 Add point of extra load — create a point in which a load is defined; 
 Delete point of extra load — delete a point where a load is defined; 
 Points of extra load — edit the coordinates and load values in additional points; 
 Add borehole — add a borehole to the model; 
 Delete borehole — delete a previously added borehole; 
 Borehole properties … — invoke a dialog box to specify soil and borehole properties; 
 Coordinate origin … — move the coordinate origin to another location; 
 Point to calculate compressible massif — indicate a point in which the compressible massif’s depth is to 

be found; 
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The Properties menu contains the following actions: 
 Settings — invoke a dialog box to set up preferences and settings; 
 Grid spacing — specify a spacing for the coordinate grid; 
 Grid — display the coordinate grid in the working field; 
 Coordinate axes — display coordinate axes of the site; 
 Fields in buildings — choosing this option will visualize the soil reaction coefficient isofields not only 

under the foundation but under adjacent buildings as well; 
 Additional points — create points on isofields in which to display markers with values of the soil reaction 

coefficients; 
 Zoom in — zoom in the view of the site in the working area; 
 Zoom out — zoom out the view of the site in the working area (this action is available only after the view 

has been zoomed in); 
 Zoom to selection — zoom in to the view of a site’s fragment selected by a rectangular rubber frame; 
 Fit — display the original view of the whole site. 

The Tools menu helps invoke useful utilities such as the standard Windows calculator, a calculator of 
formulae, a unit of measurement conversion program. 

The Help menu suggests the access to helpful reference information. 

1.4.4 Status bar 

 
The status bar (Fig. 1.4.4-1) contains two fields: the coordinates of the current mouse pointer’s location 

and the Distance. The former displays the pointer’s coordinates. The latter is used for displaying the distance 
between two points of the site in the measurement mode. 

 

Fig. 1.4.4-1. Status bar 

1.4.5 Pointers 

All operations in the working field are done using the mouse pointer. As the pointer is moved along the X 
or Y directions around the screen or as some commands are invoked, the pointer may change its appearance. For 
example, it becomes an arrow when you are about to choose a menu item or click a toolbar button; when a 
command is being processed, the pointer looks like a sand-glass (a wait pointer); when in the working area, the 
pointer is a crosshair. 

Using the pointer, you can find the distance between any two points of the site. To do this, move it to the 
first point and left-click. Keeping the left key depressed, move the pointer to the second point. The right sector of 
the status bar will indicate the distance between the points (the accuracy of this indication will depend on the 
number of decimal digits specified on the Units of measurement tab of the Settings dialog box). The coordinates 
of the current pointer’s position are displayed in the status bar, too. 
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1.5 Actions 

Placing the pointer onto a button of the toolbar and left-clicking will invoke an action or command. This 
sequence of operations will be referred to as “clicking a button of the toolbar”. 

1.5.1 New 

 

Fig. 1.5.1-1. A message box 

 
This action is used to create a new site. After it is per-

formed, the program’s window returns to its original state. If the 
current site has been modified but not saved, a message box will 
appear with a warning and a suggestion to save the file (Fig. 1.5.1-
1). 

1.5.2 Open 

 

Fig. 1.5.2-1. The 
Load site dialog box 

 
This action is used to load a previously created site. 

Invoking this action will open a standard MS Windows dialog with 
a list of files having the .crs extension (Fig. 1.5.2-1). As in the 
previous case, a check is performed and a warning/suggestion to 
save the current site is displayed if necessary (Fig. 1.5.1-1). 

1.5.3 Save 

 

Fig. 1.5.3-1. The 
Save site dialog box 

 
This action saves data of the current site to its file. If the site 

has not been saved before, invoking the action will open a standard 
Windows dialog in which to enter a name for the file (Fig. 1.5.3-1). 

1.5.4 Save As... 

This action is intended for saving data of the site in a file under a new name. Invoking the action will open a 
standard Windows dialog in which to enter a new name for the file (see Fig. 1.5.3-1). 
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1.5.5 DXF, DWG formats 

 

Fig. 1.5.5-1. The  
Open dialog box 

 

The description of geometry of a foundation can be 
imported from the AutoCAD environment as a DWG or DXF 
format file. The following graphic primitive types are recognized: 

 3DFACE 
 SOLID 
 TRACE 
 LINE 
 POLYLINE 
 LWPOLYLINE 
 ELLIPSE 
 CIRCLE 
 ARC 

This mode is invoked by the Import DXF, DWG item of 
the File menu. Before the file is loaded, the Units of measurement 
in AutoCAD files dialog box appears (Fig. 1.5.5-1) where you 
should choose the units of measurement using which the model was 
created in the AutoCAD environment. The unit is selected from a 
list. 

1.5.6 Calculate 

 

Fig. 1.5.6-1. The Calculation results 
dialog box 

 
Clicking this button activates the calculation of the soil 

reaction coefficients. After the calculation is done, the Calculation 
results dialog box appears (Fig. 1.5.6-1) which lists maximum and 
minimum values of the coefficient, the bottom level of the 
compressible soil massif, and the thickness of the compressible soil 
massif at the point it has been determined (if no rock bed is 
specified), the root-mean-square value of the soil reaction coeffi-
cient, the root-mean-square deviation of the soil reaction coeffi-
cient, the total load on the foundation, the maximum subsidence, 
the root-mean-square subsidence, and the tilt of the foundation. 
Also, in this dialog you can choose the number of color ranges to 
depict the isofields or change the bounds of intervals if necessary. 

The root-mean-square deviation serves for making a 
decision in each particular case whether the root-mean-square value 
of the soil reaction coefficient can be used or variable values over 
the area of the foundation should be specified. 

1.5.7 Report 

 
Invoking this action will generate a report containing results of the calculation. The report is an RTF file 

(Rich Text Format). After the report is generated, an application associated with RTF files is started automatically 
(such as MS Word или WordPad). If the MS Word software is used, its version is of importance due to differences 
in the data formats. The version of the software installed on the computer should be specified among other settings 
in the Settings dialog box, the Other tab. 
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1.5.8 Fields 

 
 This action is used to build isofields of the soil reaction coefficients (Fig. 1.5.8-1).  

Controls of the color scale are contained in the Coefficients of soil reaction dialog box (Fig. 1.5.8-2). 
They enable you to control the visualization depending on the character of calculated results and available resources 
of the computer. Each range of results, thus the color too, conforms to a checkbox. Turning it on makes the results 
included in the respective range visible on the model. By turning a checkbox off, you can choose not to display 
some of the results in color if those are of little importance for the current analysis.  

 

Fig. 1.5.8-1. A foundation with an isofield 
of the soil reaction coefficients displayed 

on it 
 

 To display the results of the color scale setup on the 
screen, click the Apply button at the bottom of the dialog box. 
 A row of buttons at the top is used to change the color 
gamut of the scale. The gamut changes on the screen after the 
Apply button is clicked. 

To simultaneously turn on or off all checkboxes of the 
color scale, use the On/Off button. This button is handy in cases 
when you need to choose only a few values of the whole range. To 
do it, first, turn the scale off; second, turn on buttons with 
appropriate values and click the Apply button. 

 

Fig. 1.5.8-2. Setting up the color scale 

 The color scale dialog box can occupy any position on the 
screen. It can be closed (by the Close button) or moved out of the 
working area (if the program’s window occupies only a part of the 
screen). 
 Right-click to change the number of color ranges to be 
used for depicting the isofields or to change the interval 
boundaries.  This will open the Color scale setup dialog box (Fig. 
1.5.8-2). 
 Colors suggested for the scales are not a must. You can 
change any color in the scale or even the whole gamut, and 
remember the changes made for subsequent working sessions. To 
do it, move the pointer to a color box correspondent to the color to 
be replaced, and double-left-click. This will open a standard 
Windows color setup dialog. After the color is selected, click the 
OK button. The new color will appear in the color scale. To 
remember the new color gamut, use the Save button. After this 
action, the new color gamut will be always displayed instead of the 
previous one.  

Note that while the pointer is moved inside the foun-
dation’s area, the status bar is displaying the soil reaction coef-
ficient at the point the pointer is located right now (Fig. 1.5.8-1). 
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Fig. 1.5.8-3. A dialog with results of 
calculation in a particular point 

 

 Clicking the left mouse button will open the Calculation 
results dialog box (Fig. 1.5.8-3) for the point where the pointer 
stands at the moment. This dialog displays the coordinates of the 
point, a table describing the structure of the soil massif, the soil 
reaction coefficient, the foundation’s base subsidence. The 
subsidence data are given in assumption that the bedplate has a zero 
stiffness. 
 

1.5.9 Additional points 

 
Fig. 1.5.9-1. Isofields with additional 

markers 

 

 
 If the Additional points button is pushed, then left-
clicking will not open the dialog box of results (Fig. 1.5.8-3). 
Instead, values of the soil reaction coefficients will appear on 
isofields in points indicated by the pointer (Fig. 1.5.9-1). Clicking 
the right mouse button will open a menu in which one of two 
actions can be done: remove additional points or invoke the dialog 
box for setting up the color scale. 

1.5.10 Foundation’s base subsidence 

  
 In this mode, isofields of the subsidence of the foundation's base are displayed. Conventions of output are 
the same as when the soil reaction coefficient isofields are displayed. 

1.5.11 Save picture 

 
This action will save the picture currently on the screen as a Windows metafile (.wmf) which can be used 

afterwards to create a report document. Clicking the button will open a standard MS Windows dialog box in which 
a filename for the picture should be specified. 

1.5.12 Undo 

 
Clicking the Undo button will cancel (undo) the previous action performed. The maximum undo history 

depth is not limited. 

1.5.13 Redo 

 
Clicking the Redo button will cancel the latest Undo command. 
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1.5.14 Dimensions 

 

Fig. 1.5.14-1. The 
Overall dimensions dialog box 

 

Fig. 1.5.14-2 Displaying site dimensions in 
the working area 

 
The foundation is entered using a coordinate grid with its 

sizes limited to the dimensions of the site. The dimensions of the 
site can be specified via a dialog box (Fig. 1.5.14-1) in units of 
measurement defined on the Units of measurement tab of the 
Settings dialog box. 

After the dialog is closed, a rectangle appears in the 
working area which outlines the exterior contour of the site 
according to the specified dimensions (Fig. 1.5.14-2). 

1.5.15 Foundation 

 
Fig. 1.5.15-1. Displaying a foundation in 

the working field 

 
The exterior contour of the foundation slab is entered by specifying 
salient points (vertices) of the polygon that bounds the contour. Each 
vertex is set by left-clicking. To close up the contour, double-click 
the left button. The last vertex is joined to the first one, and the 
screen displays the outline of the foundation (Fig. 1.5.15-1). 

The salient points can stand in arbitrary positions or snap to 
nearest nodes of the grid. The snap mode can be turned on or off on 
the Other tab of the Settings dialog box. If the snap mode is off, the 
second field of the status bat displays the current coordinates of the 
pointer. If the Snap to grid option is on, the status bar displays 
coordinates of a grid node nearest to the pointer. 
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1.5.16 Editing the foundation’s outline 

Fig. 1.5.16-1. A foundation after its 
outline has been edited 

 
If a foundation has been already specified, the second 

click on the Foundation button of the toolbar will activate the 
outline editing mode. To do it, move the pointer to any point of the 
contour, wait till the pointer changes its appearance (it’ll become a 
crosshair at any arbitrary point, or a target crosshair at a salient 
point), left-click and drag the selected point to a new location. To 
fix the new salient point, double-click the left mouse button. 
Fig. 1.5.16-1 shows the bedplate after its outline has been edited. 

 

When moving vertices (salient points), you are not 
allowed to make ribs of the outline cross one another or draw 
an opening outside the contour. 

1.5.17 Existing building 

 
 

 This action lets you enter the contour for an existing 
building (or buildings). The procedure is just the same as that used 
to create a foundation’s contour. 

1.5.18 Opening 

Fig. 1.5.18-1. An example of a foundation 
with an opening 

 
This action lets you enter an opening in a foundation slab or 

an existing building. The opening is specified as a closed polygon. 
The procedure of entering and editing an opening is the same as that 
of entering/editing the outline of a foundation. 

Fig. 1.5.18-1 shows an example of a foundation with an 
opening. 

 

 A polygonal opening is not allowed to cross the outline 
of the foundation or another opening. 
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1.5.19 Assign foundation 

  In some cases one has to design a few buildings standing 
together at the same time (for example, a block in the city). It is quite 
possible that one does not know which building will be erected first. 
Accordingly, during the creation of a model it is not clear which 
building (in terms of the CROSS software) should be treated as a 
foundation and which one as an existing structure. This action lets 
you re-assign a foundation, that is, by invoking the action and 
pointing at an existing building you can assign the selected one to be 
the new foundation. The previous foundation will become an 
“existing building”. 

1.5.20 Delete 

 
 

This action deletes an opening (either in a foundation or in 
an existing building) or even an existing building. To invoke the 
action, point at an object with the mouse pointer and left click. 

1.5.21 Round angle 

 
Fig. 1.5.21-1. The 

Rounding radius dialog box 

 

Fig. 1.5.21-2. An example of a rounded 
foundation 

 
An angle is rounded by inscribing a circle of a given radius 

in it. After you invoke the action, point at the contour’s vertex (it 
may belong to either the foundation’s exterior contour or that of an 
opening), wait till the pointer becomes a crosshair, and left-click. In 
the Rounding radius dialog box that opens (Fig. 1.5.21-1) specify 
the radius and click OK. Fig. 1.5.21-2 shows a foundation with one 
of its angles rounded. 

The number of points (nodes) on the arc must be specified 
on the Other tab of the Settings dialog box. The number of nodes on 
the full circle (including any interior opening) should not be less 
than 8. 

1.5.22 Move 

 

 
This action helps move a group of vertices selected by the 

frame. Do the following: 
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 invoke the action; 
 grab vertices to be moved by a rectangular (or polygonal) 

selection frame; 
 move the pointer inside the frame, wait till the pointer 

changes its appearance, and move the frame together with 
the grabbed vertices to a new position. 
Left-click to fix the new position. 

 

 

When moving vertices, you are not allowed to make ribs 
of the foundation’s outline cross one another or draw a polygonal 
opening outside the contour. 

1.5.23 Vertices 

 

Fig. 1.5.23-1. The  
Coordinates of vertices dialog box 

The positions of vertices of a foundation’s contour can be 
adjusted by changing their coordinates. To do it, use the Vertices 
item of the Edit menu. Clicking this item will display the 
Coordinates of vertices dialog box (Fig. 1.5.23-1) that includes a 
list of contours in the order of their creation and a table of 
coordinates of vertices belonging to a selected contour (a 
foundation, an opening, or an existing building). 

To adjust a vertex’s position, do the following: 
 select a contour in the list (vertices of the selected contour 

will be numbered in the section); 
 change the coordinates of the vertex in the coordinate table; 
 click the Apply or OK button. 

 

When moving vertices, you are not allowed to make ribs 
of the foundation’s outline cross one another or draw an 
opening outside the bedplate’s contour. 

1.5.24 Delete vertices 

 
This action is used to delete one or more groups of selected vertices. To do it, follow this procedure: 

 invoke the action; 
 use the rectangular or polygonal selection frame to grab the vertices to be deleted; 
 left-click the mouse. 
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1.5.25 Load 

 
This action is used to specify a load applied at the founding level, and the founding level itself. Do the 

following: 
 invoke the action; 
 point at an object (a foundation or an adjacent existing building) to which to apply the load, and then left-

click; 
 specify the magnitude of the load and the founding level in the Load dialog box that opens (Fig. 1.5.25-1). 

The subsidence of the soil bed W (see Fig. 1.5.25-2) depends on the applied load P nonlinearly, therefore, 
generally, the coefficient of the soil reaction should be a variable. 
 

 

Fig. 1.5.25-1. The Load dialog box 
 

 In the engineering practice, the nonlinear relationship 
OBA is usually replaced by the linear dependence OB (a “chord 
modulus” analysis). Tangent of this linear plot’s inclination is 
exactly the coefficient of soil reaction. 

 
Рис. 1.5.25-2.  

 Therefore the applied load Р0 should have a most probable 
expected value (such as the dead weight load plus sustained load 
plus a sustained part of short-term loads). The actual structure may 
be subject to other loads too, but if the main part of the load has 
been taken into consideration then small variations between Р0,1 
and Р0,2 will affect the coefficient of the soil reaction very little (the 
inclination of the ОВ1 and ОВ2 lines is hardly different from that of 
ОВ). 

1.5.26 Create area of extra load 

 
 A non-uniform load upon the foundation is simulated by introducing an area or a point subject to an 
additional load. After this action is invoked, use the mouse pointer to enter any desired polygonal shape for the area 
of additional load. To finish the entering, double-click the mouse, and this will open the Load dialog box where you 
should specify a value for the load. 
 An area of additional load can be created by this action via the main menu or via the respective button of 
the toolbar. After that, use the mouse pointer to draw a polygonal area. Double-click to finish entering the loaded 
area. Then, enter a value for the load in the dialog box that opens. The entered load value will be added to the 
uniform load upon the foundation specified earlier using the Load action. 

1.5.27 Delete area of extra load 

 
 To delete an area subject to an additional load, invoke the action Delete area of additional load, point at 
an area to be deleted, and left-click. 



C R O S S  

19 

1.5.28 Change load on area 

 
 A load applied to an area can be modified. To do it, invoke the action, point at the desired area, left-click, 
and specify a new value for the load in the dialog box that opens. 

1.5.29 Add point of extra load 

 
In cases when a load in a certain convex area changes according to a linear law, you can enter only points 

that bound this loaded area. The load at points inside the area will be calculated by linear interpolation of the load 
values entered for the bounding points and added to any load specified earlier. These points (three at least) are 
entered using the Create point of extra load action from the Edit menu. After each point is entered, you are asked 
to specify a load value for it. 

Note that the load in additional points must be specified in units of pressure — please do not confuse these 
points with those subject to concentrated forces. 

1.5.30 Delete point of extra load 

 
 Points of extra load can be deleted using the appropriate item from the Edit menu. 

1.5.31 Points of extra load 

 
 The Change load values in points function enables you to make changes to load values or coordinates of 
points in a table. 

1.5.32 Load field 

 
 To verify that the loads on the foundation have been specified correctly, you can use the Load field action 
and get a picture of load isofields. 

1.5.33 Add borehole 

 
 This action is used to assign a location for a borehole on the construction site. To enter a new borehole, 
point at its location with the mouse and fix it by left-clicking. The working area will display a label with No. of this 
hole (or its name if any has been specified). If the snap-to-grid mode is enabled, then the borehole will be added at 
nodes of the grid nearest to the position of the pointer. You can modify the coordinates of a borehole in the borehole 
properties setup mode. 

1.5.34 Delete borehole 

 
 To delete a borehole, point at it with the mouse pointer and left-click. 
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1.5.35 Borehole properties 

 
 Invoking this action opens the Borehole properties dialog box (Fig. 1.5.35-1) in which the following 
information should be specified for each hole: 

 coordinates of the hole (they were specified when the hole was added, but changes can be made to them in 
this dialog); 

 name (entitlement) for the hole; 
 soil information; 
 levels of soils (top) for every borehole. 

If there is a rock bed under the soil layers, enable the respective checkbox. The calculation of the 
subsidence will be limited by the level of the deepest soil layer. The latter’s name in the table will be replaced by 
“rock”. Otherwise, the program will determine the depth of the compressible soil massif on the basis of the 
assumption that the deepest layer is infinitely deep. 

 

Fig. 1.5.35-1. The 
Borehole properties dialog box 

 

Fig. 1.5.35-2. The 
Soils dialog box 

 

Fig. 1.5.35-3. Determining the effective 
stress leap 

The specification of the borehole properties must be 
preceded by a description of all soil characteristics. These  
characteristics are specified in the Soils dialog box (рис. 1.5.35-2). 
Before entering the properties of a soil, click the Add button. This 
is what must be specified in the new line of the soil table: 

 name of the soil; 
 specific weight; 
 modulus of deformation; 
 modulus of elasticity (if this property is set to zero, it will 

be calculated automatically as D/0.12 where D is the 
modulus of deformation); 

 Poisson ratio; 
 over-consolidation ratio; 
 over-consolidation pressure. 

In the last column you can assign a color to designate the 
soil in sections. 

The leap of effective stress is caused by buoyancy which 
lessens the volume weight of soil by 1 t/m3 beginning from the 
phreatic surface and ending at the aquiclude. This effect disappears 
on the aquiclude, and thus the leap of the effective stress arises 
(Fig. 1.5.35-3). 
 If saturated soil is located under waterproof one, then the 
buoyancy creates a negative leap of the effective stress. 
 One of key properties that describe the soil behavior is the 
structural strength pc. The pc value can be represented as 

pc=R +pc , 
where R is the over-consolidation ratio (related to the age of the 
soil massif), pc is the over-consolidation pressure (related to 
maximum pressures that affected the soil in the whole history of its 
formation),  is the natural pressure. The over-consolidation ratio 
and the over-consolidation pressure are constant, and they can be 
treated as soil properties.  

If there are no experimental field data about the values of R and pc, you are recommended to use the 
over-consolidation coefficient of 1.0, and the over-consolidation pressure of: 

5 t/m2  — for clayey soil; 
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2.5 t/m2  — for sandy clay; 
 0 t/m2 — for sand. 

If any of the soils needs to be deleted, select the respective line with the mouse pointer and click the Delete 
button. 

Having finished entering the soil properties, click the OK button to close the Soils dialog box and return 
control to the Borehole properties dialog. 

To describe the sequence of layers in a borehole, do the following: 
 choose No. of the borehole from the No. of borehole list; 

 select the line with properties of the layer’s soil in the Soils table (Fig. 1.5.35-1) and click the  button 
to move it to the Layers table; 

 specify the layer’s properties (soil of the same type can occur in a few different layers). 
The properties of a layer include: the level mark and (if necessary) the effective stress leap that can be 

caused, for example, by water saturation of the layer. Note that the level marks can refer to any basic reference point 
(such as the rock bed or the day). 

The entering of the borehole properties can be facilitated in this way: enter only one borehole and edit its 
properties, then start entering the rest of the boreholes. Their properties will be copied from the first one by default, 
so you will need only to edit them. Also, clicking the Copy button will open the Copy borehole dialog box in 
which you can choose a “counterpart” borehole and copy its level marks from there. 

1.5.36 Point to calculate compressible massif 

 If no rock bed is specified for the model, then the bottom level of the compressible massif will be 
calculated at the central point of the foundation slab. Using the Edit menu, you can invoke the action Point to 
calculate compressible massif, and use your pointer to indicate a different location for this purpose (it will be 
indicated by a red cross on the model’s view). 
 If the foundation has a nearly rectangular shape, then the recommended point for calculating the 
compressible massif depth will be the middle of a line that connects one of the rectangle’s vertices with its 
diagonals’ intersection point. 

1.5.37 Cancel 

 
 Clicking this button will cancel the currently invoked action, and you can use such functions as the 
distance measurement, construction of sections etc. 

1.5.38 Section 

 

Fig. 1.5.38-1. A dialog box that shows a 
section 

To validate given properties of boreholes, you can use the 
geological section mode (Fig. 1.5.38-1). The section is generated 
along a linear segment located in any place of the site. To construct 
a section, do the following: 

 use the Cancel button to disable the current action; 
 place the pointer onto the beginning of the segment; 
 press the Ctrl key and, at the same time, click and hold the 

left mouse button; 
 holding both the mouse button and the key, drag the 

mouse to the second node of the segment. 
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A dialog box will appear with a geologic section along the specified direction. A hachure line will denote 
the founding level, and a dot line will indicate the boundary of the compressible soil massif. The boundary will be 
visible only in the case it is not deeper than 10 meters below the top level of the last soil layer. 
 Use the Save menu item to save the picture as a Windows metafile, if desired. 
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The following algorithm is used to build a section:  
 

A convex envelope is constructed for all points at which the boreholes are specified. This convex envelope is 
triangulated. Further, one of three options is possible for every point inside the construction site: 
 

  
Fig. 1.5.38-2. 

 
 

 
 
 
 

A the point lies inside one of triangles (an example is the A point in 
Fig. 1.5.38-2); 

B the point is outside the convex envelope, and the distance from this point 
to the convex envelope is equal to the length of a normal dropped on the 
nearest side of the envelope (an example is the B point in Fig. 1.5.38-2); 

C the point is outside the convex envelope, and the distance from this point 
to the nearest side of the convex envelope is equal to the distance to one 
of the vertices (an example is the C point in Fig. 1.5.38-2); 

 

 
Fig. 1.5.38-3. 

 
 
In case A, the thickness of each soil layer is calculated by linear 

interpolation between the vertices of the triangle, proportionally to the areas of 
the triangles opposite to their respective vertices (Fig. 1.5.38-3). 

 
 
 

 
Fig. 1.5.38-4. 

 
 
 
 
 
 
In case B, the thickness of each soil layer is calculated by linear 

interpolation of the lengths of segments into which the side is divided by the 
normal dropped from the B point (Fig. 1.5.38-4). 

 
 
 
 
 
 
 
In case C, we assume that the structure of the soil massif in the 

current point is the same as that in the nearest borehole (it is borehole 3 in 
Fig. 1.5.38-2). 
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Note the impossibility to restore the structure of a soil massif only by information about the structure of 
boreholes. This can be seen from the following simple example. Suppose there are two boreholes of the following 
structure: 

Borehole 1 Borehole 2 
Soil Top level Soil Top level 

Clayey 0 Sand 0 
Clay -10 Clayey -10 

 
The axial geologic section can be like that: 

 

 
 
 
 
 
 

Or 

 
The ambiguity of this kind can be eliminated by specifying the same package of soils for every borehole. 

That is, in each borehole the set of soils and their order should be the same (only their top levels are different), 
while the lack of a soil (say, ith) in a certain borehole should be specified as equal top levels for ith and (i+1)th soils. 
In the example above, the structure of the boreholes should be described as follows (suppose the second section is 
the correct one). 

 
Borehole 1 Borehole 2 

Soil type Top level Soil type Top level 
Песок 0 Sand 0 
Clayey 0 Clayey -10 
Clay -10 Clay -10 

1.5.39 Measuring distances 

 Using the mouse pointer, you can determine the distance 
between any two points of the site. To do it, move the pointer onto 
the first point, click and hold the left mouse button, and move the 
pointer onto the second point. The right sector of the status bar will 
indicate the distance between points (the accuracy of this indication 
will depend on the number of decimal digits specified on the Units 
of measurement tab of the Settings dialog box). The coordinates 
of the current pointer position will be displayed in the middle of the 
status bar. 

Note that, in order to be able to perform this action, you 
should turn off all edit modes. 
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1.5.40 Coordinate origin 

 

Fig. 1.5.40-1. The  
Coordinate origin dialog box 

 
This action is invoked from the Edit drop-down menu and 

lets the user move the coordinate origin to a point with specified 
coordinates (Fig. 1.5.40-1).  

The grid is turned around the coordinate origin, therefore 
moving it can be useful when specifying a contour. 

1.5.41 Grid spacing 

 

Fig. 1.5.41-1. The Grid settings dialog 
box 

 

Fig. 1.5.41-2. A grid displayed in the 
working area 

 

 
Properties of the coordinate grid are set up in the Grid 

settings dialog box (Fig. 1.5.41-1) that opens by invoking the 
appropriate action. Edit fields of this dialog lets you specify the 
horizontal grid spacing (by X) and the vertical one (by Y), together 
with an inclination of the grid with respect to the horizontal axis 
expressed in degrees. The grid is rotated around the coordinate 
origin. 

Note that the grid spacing and its inclination angle can be 
altered as many times as needed in the course of contour 
specification. That’s how you can adjust the grid to the sizes or 
orientation of the contour being entered. 

The grid appears on the screen after all its settings are 
specified (Fig. 1.5.41-2).  

1.5.42 Grid 

 
 

This will turn on or off the displaying of the dimension 
grid in the working area. The spacing of the grid is assigned by the 

Grid spacing property in Settings or by clicking the  button 
on the toolbar. 
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1.5.43 Fields in buildings 

 

Fig. 1.5.43-1. A foundation model together 
with an adjacent building 

 

 

Fig. 1.5.43-2. A soil reaction coefficient 
field in the foundation and its adjacent 

building 

 
The program can give out fields of coefficients for 

existing buildings, too, if the respective option has been enabled in 
Settings. As a rule, such information about the distribution of soil 
reaction coefficients under existing buildings is not of much 
importance for the design procedure. Nonetheless, there may be 
cases when this data is useful.  
 If the Fields in buildings action is invoked, a full picture 
of the soil reaction coefficient distribution under all buildings will 
be generated (Fig. 1.5.43-2). 
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1.5.44 Zoom in and out 

 
   

The picture of the site can be zoomed in. Each click on the 

 button — Zoom in — will increase the linear scale by 10%. 
The maximum possible scale is 2:1 comparing to the original size. 
If the picture has been zoomed in, scrollbars appear along the right 
and bottom borders of the working area. The scrollbars can be used 
to move the picture around in the working area. For zooming out, 

use the  button — Zoom out — to decrease the scale by 10% 
with each click down to the original size of the model fitting the 
window. 

1.5.45 Zoom to selection 

 
 After invoking this action, use a rectangular selection 
frame to select a part of the model. After the right mouse button is 
clicked, this selection will be zoomed in. 

1.5.46 Fit 

  This action will return the picture of the site to its original 
size that fits the window. 

1.5.47 Help 

 
 

Clicking the Help button will invoke a standard MS 
Windows function for getting reference help information from a 
database created by the program’s developers. 

1.5.48 About 

 

Fig. 1.5.48-1. The About message box 

 

 
Clicking this button will open the About message box 

(Fig. 1.5.48-1) that displays the version number and the developer 
of the program. 
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